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PREFACE

Product lifecycle management (PLM) originated from two roots. One s
enterprise management, which can be further subdivided into material resource
planning (MRP), enterprise resource planning (ERP), customer relationship
management (CRM), and supply chain management (SCM). Because of the
visibility across the complete lifecycle of a product, the attendant risks can be
estimated. In this sense, PLM serves as a decision support tool.

The other root is the management of product information throughout the
entire lifecycle of the product. In this context, system integration facilitates the
collaboration among virtual enterprises.

Global Aircraft Information Life Cycle Support plays a major role here.

The Aircraft information space nowadays involves a lot of computer
information technologies and software products. The Computer-Aided Design
and Manufacturing(CAD/CAM), product data management (PDM) systems.
Aviation databases, Computer Based Training, Virtual environment tools are
among them.

The aircraft information space contains different types of information:
numerical, verbal, graphical, text, linguistic and mixed data.

The use of PDM systems required engineering knowledge.

With the advent of the Internet, web-based PDM systems became more
accessible to suppliers and other parties outside of the enterprise.

PLM extends PDM beyond engineering and manufacturing into more
strategic areas like marketing, finance, and after-sales service throughout the
lifecycle of the product .

During the life of a product, a large amount of data is generated. This
includes CAD data, specifications, quality documents, bill of materials.
engineering simulations, etc., which are shared throughout the extended
enterprise . All participants of Life Cycle create, manage, disseminate, share and
use product information.

This Laboratory Guide is intended for mastering students in major
computer information technologies and software products, which are the
members of product data management, and aircraft in particular.
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LABORATORY WORK # 1. Investigating the structure of an
aircraft life cycle and developing the LC conceptual model

Key words: product life cycle, LC phases, LC management, LC cost, LC
members, ontology, problem domain, information space, LC support, design
stages, conceptual design, outsourcing

Objective of the laboratory work: to develop the conceptual model of an
aircraft life cycle using different information sources: both technical papers and
Internet resources.

Preliminary knowledge and skills
Student must know:

* Aircraft operation.

* Flight operation.

* Technical operation.

* Aircraft handling, ground servicing.

* General notions on aircraft maintenance.
Student is to be able:

To perform the information search in the Internet.
Knowledge after the performing the laboratory work
Student must know:

* The Aircraft LC structure and phases.
* Basic notions: information space, ontology, problem domain, conceptual
model.
Student is to be able:
* To define the problem domain.
* To develop the ontology of the problem domain.
* to develop the generic aircraft life cycle conceptual model.

Theoretical background

Information space is the set of concepts and relations among them held
by an information system; it describes the range of possible values or meanings
an entity can have under the given rules and circumstances. Information spaces
surround us. When we retrieve a file from our computer, we are browsing
through an information space; when we use a search engine we are sifting
through an information space; and when we visit a website we are moving
through yet another information space.

Another definition is that the information space are the total results of

the semantic activity of the humanity, "the world of names and titles",
conjugated to the ontological world.




STUDENT LABGUIDE Aircraft LC supporting CIT

Laboratory work #1

Ontology (from cnto-, from the Greek v, ovrog "being; that which is”.
present participle of the verb eiu/ "be", and -hoyig, -logia: science, study, theory)
is the philosophical study of the nature of being, existence, or reality, as well as
the basic categories of being and their relations. Traditionally listed as a part of
the major branch of philosophy known as metaphysics, ontology deals with
questions concerning what entities exist or can be said to exist, and how such
entities can be grouped, related within a hierarchy, and subdivided according to
similarities and differences.

Principal questions of ontology are "What can be said to exist?", "Into
what categories, if any, can we sort existing things?", "What are the meanings of
being?", "What are the various modes of being of entities?".

One common approach is to divide the extant subjects and predicates into
groups called categories. Such an understanding of ontological categories,
however, is merely taxonomic, classificatory. The categories are, properly
speaking, the ways in which a being can be addressed simply as a being, such as
what it is (its 'whatness', quidditas or essence), how it is (its 'howness' or
qualitativeness), how much it is (quantitativeness), where it is, its relatedness to
other beings, etc.

A problem domain is the area of expertise or application that needs to be
examined to solve a problem. A problem domain is simply looking at only the
topics you are interested in, and excluding everything else. For example, if you
were developing a system trying to measure good practice in medicine, you
wouldn't include carpet drawings at hospitals in your problem domain. In this
example the domain refers to relevant topics solely within your interest:
medicine.

In mathematics, the term defines a domain where the parameters defining
the  boundaries of the domain and  sufficient mappings into
a set of ranges including itself are not well enough understood to provide a
systematic description of the domain.

In this context see information theory as the idea behind a domain as a
minimal set of sources for mappings relative to the problem a specific instance
of applying.

Having defined a specific problem domain with sufficient parameters and
mappings for consultation, a systematic approach to the solution can be
developed in accordance with the Parker Rule. Using this rule, it is implied that
any topics not directly associated with the initial problem domain, and its
immediate mappings should not be included within the problem domain, but

7
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should be considered as parameters of the secondary mappings of any associated
domains.

A domain model in problem solving and software engineering is
a conceptual model of all the topics related to a specific problem. It describes
the various entities, their attributes, roles, and relationships, plus the constraints
that govern the problem domain. The domain model is created in order to
represent the vocabulary and key concepts of the problem domain. The domain
model also identifies the relationships among all the entities within the scope of
the problem domain, and commonly identifies their attributes. A domain model
that encapsulates methods within the entities is more properly associated
with object oriented models.

An important advantage of a domain model is that it describes and
constrains the scope of the problem domain, and can be effectively used to
verify and validate the understanding of the problem domain among various
stakeholders.

ConceptualA model is a representation of some phenomenon, data or
theory by logical and mathematical objects such as functions, relations, tables,
stochastic processes, formulas, axiom systems, rules of inference etc. A
conceptual model has an ontology that is the set of expressions in the model
which are intended to denote some aspect of the modeled object.

Preliminary unsupervised student’s work (4 hours)
1. To carry out the information retrieval, and literature search on the subject.
To investigate aircraft life cycle problem domain. To generate the
ontology of the problem domain.
2. To define the ontology of the problem domain.
3. To develop the ontograph of the ontology defined.

Progress of work
1. To select the concrete aircraft. To investigate the specifics of its LC. In

order to do this, follow the criteria, given below:

1.1.An aircraft has designed without the prototype (absolutely new idea)
or according to the existing aircraft. If the aircraft is designed
according to the prototype, carry out its generic analysis (type, general
operational characteristics).

1.2.Actual position on the market.

1.3.Perspectives of operation in future.

1.4.Location of outsourcers and their general characteristics.

8
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1.5.Airlines-operators.
1.6.Computer information communication technologies used in the

process of operation.

1.7.Using of CALS-technologies.
1.8.LC cost.
1.9.Accidents.
2. To arrange the Introduction to the First homework “Conceptual model of

the aircraft ....” (3 pages minimum).
3. Using the ontograph, to develop the conceptual model of the problem
domain.

4. Draw the sketch of the conceptual model.

Control questions

-l S

oo S F o

Give the definitions of key notions: product life cycle, LC
management, LC cost, LC members, ontology, problem domain,
information space, LC support, design stages, conceptual design, and
outsourcing.

Explain the purpose of each LC phase.

Give the examples of using computer information technologies in the
frame of an aircraft LC phases.

Give the generic characteristic of an aircraft life cycle cost assessment.
Explain the essence of outsourcing.

Explain the essence of Green Design.

Give the general characteristic of CALS technologies.

Give the general characteristic of the problem “Aircratt at the end of
life sector”.

References to the Laboratory Work #1 are given in the folder
“References to the LW#1” on CD.
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LABORATORY WORK # 2. Basics of CAD/CAE technologies

Key words: computer-aided design, computer-aided engineering, engineering
drawings
Objective of the laboratory work: to develop the technical drawing and the
conceptual 3D model of an object.
Preliminary knowledge and skills
Student must know:
* Fundamentals of technical drawing
* General effective drawing standards
Student is to be able:
* Understand technical drawings.
* To draw manually
Knowledge after the performing the laboratory work
Student must know:
Fundamentals of technical drawing by means of Computer Aided Design
System.
Student is to be able:
To create simple drawings and 3D models by means of Computer Aided
Design System.

Theoretical background
Google SketchUp is a program which lets you sketch in 3D. It is excellent
for creating buildings, houses, and mechanical designs.
Google SketchUp basics.
1. To run the product: double-click the Google SketchUp icon A ’
The start screen is shown on Figure 2.1.

# Untatied - Sketchip Pro &
He Edt Vew Comers Dyae Jock Wrdow Phgns tep

P LBOCI ¢ PBLEDF Y AR L2106 [@0@@D o 2V ¢ 0m

=

40E >
BN & O

SPEFVEON
‘fﬁ.ﬂ\ﬂ‘k’ﬁ'ﬁ"’ﬁlﬂ(“

L9

-..‘b

—

Figure 2.1.-Google SketchUp start screen

10
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2. Panels of tools:

e cor’r\\A ct::an‘r Get
line P current
Tape  Push/ view o e

measure  pull  Rotate Orbit Zoom model

¢ Untitl2d - SketciUp
Fila Fer | View Camgra

Draw  Tdole Winddw Help

Clgra

\ f
|

it @

Laboratory work #2

Share
model

EORREEEER

Select  brawa Erase Move/ Offset Pan  Zoom 1999/  Get
something  box something Copy extents T€TaN  models
Draw an Paint
e bucket
Large Toolset Toolbar

Select View - Toolbars -Large Tool Set

Select something
Paint bucket

Draw a polygon

Move/Copy ——,
Rotate
4

Scale

Draw a box !ﬁ
Draw a circle g—
%

Tape measure

Protractor
Reset the Axes

Orbit

The Views Toolbar Zoom

Select View Toolbars -Views

Previous view ?ﬂj
jﬁ? @ - ‘osition camera ———’ﬂ ;

ATEST AT )

1
1T 1T 1 %
30 Top Front Right Back Left Wﬂlk e
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Make component
Erase something
Draw a line
Drow an arc
Draw freehand
Push/pull

Follow me
Offset

Add dimensions
Add text

Add 3D text
Pan

Zoom extents
Next view

Look around

Sectinn nlne
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3. SketchUp “Inferences”

SketchUp uses Right Hand Coordinate system.

One of SketchUp’s key strengths is that it doesn’t require you to enter
every little piece of information as many 3D computer programs do. Instead, it
tries to infer what you really mean by how you do things. Oftentimes it uses
colors to tell you what it is inferring.

— Green dots = Endpoints

— Red dots = On an edge

— Cyan dots = Midpoints of edges

— Blue dots = On a surface

— Red line = X axis

— Blue line = Y axis

— Green line = Z axis

— Magenta line = something is parallel or perpendicular to an edge
Hold SHIFT to capture and lock an Inference.

4. Drawing a 2D Box e it s o
Click on the Draw-a-Box icon, |[x AB®C| . &0 BLEIF|H 2.
then click on the origin, and while ~
holding down the mouse, drag in

This is called
this direction: — (Figure 2.2) . The Origin \

. o~ '\'w
Th(\e result \i\\\/

Figure 2.2.- Location of the Draw-a-Box icon

This is the Measurement Toolbar, or
MTB. It is used to show you the
dimensions, size, angle, etc. that you are
currently setting

It can also be used to set exact values —
just type into it while you are sizing with
b the mouse. But, if inputting length, be sure
v ‘ to use units: * for feet and » for inches.

£ s

Dimensons &2 1/8°, 104 9/16°

12




STUDENT LABGUIDE Aircraft LC supporting CIT

5. Extruding into a 3D Box
Click on the Push/pull icon

just created, and while holding down the mouse, drag in this directionT

# untitled - SketchUp Pro &

Laboratory work #2

(Figure 2.3), then click on the box you

(Be EGl Wew Comera Diaw Joos Window Phigine tiep ——— E——— 7%-
[* ZBOC| ¢ PBLECE HEARD (BLDEF  [PO@PDO TV ¢ o=
LIRS

B8I )
B
ec

v®

2L

5318 P

5E ush-Pull

P | | button

F =

Xk &

/2

QUA

% 57

Le

oD

@ © | (@ Pick face w0 push or pull, Crrl = toggle create new startng face.

Distance [1,031m

Figure 2.3.- Extruding into a 3D Box

6. Deleting an Object

e

¢ Untitled - Sketchup
kAt Vew Camera Craw 1ok Sindaw  Help

ZWVYEOC JPBELXSE

. Select the Select icon

. Select the object to delete by dragging
a box around it with the cursor

. Hitthe Delete key (not Backspace)

13
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7. Adding more detail to an existing face

# Untitled - Sketchlp

Tools ‘Window Hsip

P PHLRXCEFSZARO L= @
S e ——————— = -

Click on the Draw-a-circle icon, then

click on one face of the 3D solid you
___——— Just created, and while holding down

the mouse, drag in some direction

Click on the Push/pull
icon, then click on the
circle you just created,

~and while holding
down the mouse, drag
in this direction

-

Pushing a hole and cutting a hole

# Untitled - SketchlUp

gk Ymn Corwrs DT w1 o— S ——
[+ /B0C ¢2ALkBF 2RO L@y

p—y

If you erase the circle by
clicking on the circle, then
hitting Delete (not
Backspace), you get a
window cut in the wall.

If you push the circle in,
you get a tunnel with
walls and a back face

14



8. Change the point of view

¢’ Untitled - SketchUp
File Frt  Wiew Camera Drsa Toole Window  Help

/B ¢ PB L

CERILRAD - = &

oo —

9. Zooming

Fle FEdr Yiew Camera Draw Tools Widow Help

N /BOC| & PB|L A

Click on the Orbit or Pan icon, then click
in the scene, and while holding down the
mouse, drag in some direction

You can also Orbit by pushing down
on the middle button on the mouse.
On many mice, the middle button is
also the scroll wheel.

CEBAIRD @

N BB GEA NCT@ISAS . SeV

The Zoom extents icon will
in as much as possible
/witho t making any of your
— object disappear off the
scree

The Zoom icon will allow you
to zoom as much or as little
as you want

You can also Zoom in and out with
the scroll wheel on the mouse

15




10.Coloring
Toolsr{ \@:nciuw Plugins  Help

Model Infa

Entity Info

—

Components
Styles

Lavers
Cutliner
Scenes

Shadows
Fog

Match Photo
Soften Edges
Instructor

Preferences

Hide Dialogs

Ruby Console
Component Options
Component Attributes
Photo Textures

11.Dimensions

W | Tools Window Plugins Help

l v Select Space E

Eraser E
Paint Bucket B

Move M
Rotate Q
Scale S

Push/Pull P

Click Window -Materials

Select Colors

2. Treat the color just like

you did the material

Scroll up and down to
get more colors

# Click Tools Dimensions

Follow Me
Offset F

Outer Shell
Solid Tools

Tape Measure T
Protractor
Axes

Text
3D Text

Section Plane

Utilities
Interact
Sandbox 4

/ 1. Click on an edge
2. Drag where you want the
dimension to be drawn

Dimensions are useful if
you are giving your design

to someone so that they
can build it

1. Click on the
circumference of a circle

et Drag where you want the
dimension to be drawn

16
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# Untitled - SketchUp

dt Yiew Camera Draw Tools  Windnw  Help

hMVYBOC| JPBLECE

File Edt Yiew

13.Scaling

R
¢ Untitled - SketchUp
t View Camera Draw Tools Window Help

1. Select the Select icon

— 2. Select the object to move

3. Click the Move icon
4. Move the object

5. Holding down the Control
key will result in a Copy
instead of a Move

A ¥BeC JdIBLECE

17

1. Select the Select icon
== 2

Select the object to scale

. Select Tools -Scale or click

the Scale icon in the Large
Toolset toolbar

. Grab a grip point and scale

the object
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14.Perspective

i - Skt rhilp Pro @

== Tamez Draw Tools Window Plugins Help

Projections

Click Camera .Perspective
Click Camera .Parallel Projection

"Vanishing Point"

Match New Photo... | 1In perspective, things get smaller
; =1 | as they get farther away, which
. & 3 3 y
i g is more realistic. In parallel, they ;
¥ ' zoom z don't. But parallel helps you see s
=—— Feld of Yiew f f + d b kf l
Zoom Window Chri+shift+w 1T Tront and back taces line up.
Zoom Extents Ctri+Shift+E &
Zoom ko Photo
: Position Camera
walk
Look Around
Image Igloo I
¢ Untitled - SketchUp Pro @
Iﬁa— Edit View Camera Draw Tools Window Plugins  Hel|
. . New ChrHN 77 4
15.Exporting an image file _ sl e G PBL
Click .Flle——>Export —2D Gre}phlc o TE
Your image can be exported in one of 4 formats: Save s..
Save A Copy As...
1' BMP Save As Template...
2. JPEG Revert
3. TIF Send to LayOut
Preview in Google Earth
4. PNG
Geo-location »
Building Maker »
3D Warehouse 3
. Import...
16.Creating groups I oo

Sometimes you would like to collect several  rrntseun..
pieces of geometry together and be able to treat R
them as a single unit (Figure 2.4). This is called a
SketchUp Group. Create a SketchUp Group by
first clicking on the Select icon.

Then, click on the first object you want in the
Group. It will turn blue. Then, hold down the Shift
key and click on all other objects you want in the
group. They will also turn blue. If you select the
wrong item, just click it again to un-select it.

18

Figure 2.4.- A group
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You can select many things at once by creating a rectangle around all of
them with the Select cursor.

When you are done, right-click and select Make Group from the pop-up
menu. To ungroup the objects, right click on them and select Explode from the
pop-up menu.

17.Adding 3D Text

1. Click on Tools—3D Text

2. Type the text into the dialog box

3. Make any text settings you want

4. Place the text by clicking on an object

18.Rotation an object

. Select the entire object
2. Click on the Rotate Tool

3. Click the Protractor onto the object

4. Rotate the Protractor with the mouse
to align it with something (e.g., a key
point) -- click when ready.

. Rotate the object. Click when done.

also type in an exact
angle into the
Measurement
Toolbar (MTB)

\ Once you've started
0 rotating, you can

hiversity
e

19




19.Scaling an object
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Scaling an Object

. Select an object
. Select Tools -Scale
. Move the grips with the mouse

. Hold down the Control key if you

/ want scaling about the object’s
: center
;
/
4
sy —— Moviﬁg a side gripﬁ__
will stretch the

object in that
direction. Moving a
diagonal grip will
scale the object
equally in all
directions ("uniform
scaling")

20.Scale just a face
1. Select a face
2. Select Tools—Scale
3. Move the grips with the mouse

4. Hold down the Control key if you

want scaling about the object’s center

20
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21.ctioning the object

Sectioning an Object

Select an object
Select Tools »Section Plane

Select the section plane

ol

Use the Move Tool to slide it into
the object

S BB LETAAAGE ARG Sed

22.Drawing an arc

Vil amsa - = 1. Click on the Arc Tool
2. Select two points for the chord

3. Select a third point that shows
SketchUp where to “bulge” the arc

" irmadgre-aRe. e ve

21
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23.Drawing sphere

1. Create a circle

2. Copy the circle using the Move Tool with the
Control key held down

3. Rotate the top circle 90°

4. Select the bottom circle, select Tools »Follow
Me, and select the top circle

5. Erase the bottom circle and Delete it

Q)
O

24.0ffsetting

. Click on the Offset Tool [(F|

. Select the surface to offset on

. Move the mouse to show how
much to offset — click when ready

. This only creates offset edges —
you need to use the Push-Pull Tool

to do something with it.@

Ad 1 LR R T LLE REY T LER )

VBB sofRsasre-aAis.wey

|
i

22
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25.Subtracting one surface from another

Note the difference
in edges

R o

Create two objects

Laboratory work #2

Use the Move Tool to overlap them

Select both objects

Select Edit :Intersect -Intersect

with Model

need

. [Erase the surfaces and lines you don't

26.Animation

To create an animation:
Create a view of the scene
Select View >Animation
Create a different view

Select View -Animation

o K G e

To play the full animation:
1. Select View -Animation

2. Pause or stop the scene with these buttons

Animation

»Add Scene

»Add Scene

»Play

23

itled - SketchUp Pro o

Zdt | View Camera Draw Tools window FPlugine Help

L G P B|E X

As you add scenes, SketchUp will list
them. You can click on any of them to

get back to that view.

X

B
/
C
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27.Animation settings

led - Sketchup Pro @
it | View Camera Draw Tools ‘Window Plugins Help

Toalbars 3 7 | & :
B dPB LY
Hidden Geomestry
v Section Planes _
v Section Cuts Moded Info - sketchup ®
v fxes
v Guides m Scene Transitions
E e e e Lomponents
Shadows Credits ¥ Enale scere transitions
¢ Fog i ish s :t
WS £ oetfontn b File 4 :I seconds
( Edge Style » Locaton
Face Style > Renderng S¢éne Delay
—  ComponentEdit » ?Lattfstics
e =zl ex

0 j seconds

Units

e R
TEE e Lipdate Stene
Del

Set how long each scene transition lasts

How long to wait before starting the animation

28.Exporting animation

1. Select File—Export— Animation
2. Save as an AVI file
To save an animation to a file: Double-click on your AVI file
To play the animation file:
1. Select Insert—Movies and Sounds—Movie from File
To import your animation into PowerPoint:
1. Double-click on the image when editing the slide
2. Click on the image in Slide Show mode

Preliminary unsupervised student’s work
1. To revise general technical drawing principles.

2. To familiarize with generic technology of an aircraft conceptual design.

3. Investigate the basic techniques of creating 3D models with Google
SketchUp (use the sources, given on CD).

4. Prepare the draft for the 3D conceptual model design.

5. Investigate the basic techniques of creating drawings with AutoCad (use the
sources, given on CD).

24
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Progress of work

1. Develop the 3D model of the selected object with Google SketchUp.

2. Develop the simple drawing with AutoCad. The examples of simple 2D
AutoCad drawings and variants of exercises are given in Appendix E.

Control questions

1. Explain the general concept of CAD/CAE technologies.

2. What aircraft life cycle phases require the using of CAD/CAE
technologies?

3. Give examples of CAD/CAE systems.

Use References

1. Google SketchUp
http://sketchup.google.com/3dwarehouse/cldetails?mid=8299198acb0062
d65ded8939d%aed569

2. Google Sketchup aircraft wing tutorial pt 1 of
2/http://www.youtube.com/watch?v=pv7dULmJUiU

3. Google Sketchup aircraft wing tutorial pt 2 of 2/
http://www.youtube.com/watch?v=Jyj-eGo-uRQ

4, Aircraft Modeling Tutorial - Part 3 "Accuracy)/
http://www.youtube.com/watch?v=Z{dWNzGOHhU & feature=related

5. 5 Year Old Designing An Airplane on Google Sketchup /
http://www.youtube.com/watch?v=Iwr8UXS-kl g

6. Useful Google Sketchup Plugins/
http://www.youtube.com/watch?v=5Fdo3telGaU & feature=related

7. Aircraft Modeling Tutorial - Part 2 "Tracing) /
http://www.voutube.com/watch?v=yK8K 1 A9w YMé&feature=related

8. Google Sketchup tutorial : How to do a car in 3D./
http://www.youtube.com/watch?v=Hgrix3m119k& feature=related

9. how to make a car in google sketchup/
http://www.youtube.com/watch?v=GR6rgXxVGPw&feature=related

10.Building a Caravelle jet airliner model using Google Sketchup 8/
http://www.youtube.com/watch?v=7vH8BSCaS5M& feature=related

11.Mini tutorial: 2D to 3D using the free app Google SketchUp/
http://www.youtube.com/watch?v=1FJilnmVGK g& feature=fvwrel

References to the Laboratory Work#2 also are given in the folder
“Sources to the LW#2” on CD.
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LABORATORY WORK # 3. Technical documents design and
keeping

Key words: e-document, file, format of file, text documents, hypertext,
hyperlinks, document management system

Objective of the laboratory work: to develop the technical documentation.

Preliminary knowledge and skills
Student must know:
* General principles of keeping technical documentation.
* Effective standards of technical documentation.
Student is to be able:
To create, edit and save documents by means of Microsoft Word.
Knowledge after the performing the laboratory work
Student must know:
*  General principles of design and keeping technical electronic
documentation.
* Formats of files for saving and keeping e-documents on computer.
Student is to be able:
* To design the templates of technical documents,
* To design, edit, save and arrange technical e-documents.

Theoretical background
Technical documentation follows the specific standards. First of all the
technical document has to be of the proper structure. As usual it contains the
following elements:
The title.
The abstract.
The contents.
Introduction.
The main body, subdivided on some parts.
Conclusions.
References.

SN B e R

The title is the first page of the document. It includes the actual title of the
document, the name of the author, the year. The example of the Homework title
is given in Appendix A.

Abstract represents the general idea of the document, the objectives,
specific aspects presented, target groups. Abstract as usual is about ] page.

The contents should be arranged in structure mode.
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The introduction represents the results of the situation investigation.
includes the problem statement, target settings and the expected approaches to
the problem solving.

The main body of the document contains some parts, which elucidate the
problem, methods of problem solving and estimating of the results.

Conclusions contain the most significant positions of the results.
suggestion, guidelines.

References contain the list of information sources.

The In the second place is the paper work and making up of the e-
document.

General principles of technical documentation making up are the next:

« Text and figures layout.
» Underlines.
 Pages orientation and numeration.
« Headers and footers.
« Fonts (type, color, size).
» Line spaces.
« Borders of the page.
+ Indentation.
Table 3.1 gives the recommended settings.

Table 3.1
# Parameter Meaning
1. Font Times New Roman
) Size 14
3 Borders of the page Left — 2, upper — 2, lower —
2, right — 1.5
4, Indentation 1.25
5. Line space 1.15
6. Header Title of the document
1 Footer Page number

All pages of the technical documentation have frames.
The 1 page of the chapter has big frame, others - small (Appendix B).

Preliminary unsupervised student’s work (4 hours)
1. Revise the skills of operating Microsoft Word (use resources to the 3
Laboratory Work from CD).

2. Get to know the advanced MS Word tools (creating templates and
contents).
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6.

To design the structure of the first Homework as technical document. The
Homework #1 is the description of the selected aircraft life cycle
conceptual model, including the 3D Sketch Up model, as the result of the
preliminary design. Recommendations to the performing Homeworks are
given in Appendix C.

- To prepare the draft of the Homework #1. In order to do this it’s necessary

to collect the information for the performing the Homework #1, namely:

* The current market situation and the position of the selected aircraft.

* General operational characteristics of the selected aircraft and its
positioning on the world marker (rating).

* Main positions of the LC management strategy.

* The ontology and onto graph of the problem domain.

* The diagram of the LC conceptual model.

* The steps of the 3D model design.

. To prepare the abstract and introduction, to define and arrange the

chapters as separate MS Word documents. Download and/or create
drawings and pictures and save them as graphic files. Arrange the list of
references.

To create the templates for the pages of the Homework #1.

Progress of work

1,

2.

To perform the integration of the technical document, using the results of
the preliminary work.
At the end arrange the contents.

Control questions

2

2 e

Give the definition of key notions: : e-document, file, format of file, text
documents, hypertext, hyperlinks, document management system.
Explain the structure of file specification.

Give examples of file formats.

Explain the general idea of hypertext.

Explain the general idea and functions of e-documents Management
System

Information sources to the Laboratory Work #3 are given in the folder
“Sources to the LW3” on CD, and Boeing 737 AMM CD.

28



STUDENT LABGUIDE Aircraft LC supporting CIT

= TL A 7

Laboratory work #4

T RN IR T O o S e A P L o W e P e NS AP "

LABORATORY WORK # 4. Developing the Computer Based
Training System for technicians

Key words: computer based training, e-learning, WEB-based learning, distance
learning

Objective of the laboratory work: to develop the electronic manual for
aviation maintenance technicians.

Preliminary knowledge and skills
Student must know:
1. General professional requirements to the aviation engineers and aviation
maintenance technicians (AMT)
2. The notions of information space, problem domain, ontology.
3. The basic principles of developing ontology, algorithms and flow-charts.
4. General concept of WEB-based learning, e-learning, computer-based
training
Student is to be able:
1. To operate with Microsoft Word options, such as lists, tables and
graphics.

Knowledge after the performing the laboratory work
Student must know:
1. General principles of creating hypertext documents.
Student is to be able:
1. To investigate the problem domain of the concrete technical
operation task (for instance, handling or maintenance operations).
2. To develop the ontology of the problem domain.
3. To develop the algorithm of the operation.
4. To create the hypertext training manual on the selected operation.

Theoretical background

The CBT is a specific environment, which is realized by the mean of
some computer system (software). The background of this system contains the
multi-branched algorithm of training situations. The regular CBT system gives
the opportunity to study the new theme in the interactive mode, using text,
video, slideshow, verbal explanation. At the end of each theme the testing
exercises are offered.

As usual the CBT session starts from the selection the current training
theme. The list of themes is interactive, and it has hierarchical structure (Figure
4.1).
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A LA330-300 / GE LINE & BASE AVNCS/FLECS COURSE (Metric Units) B ] JE |
Help
= 1 £ GE LINE & § | ©1 01 GENERAL =
£ 01 GENERAL O ™ A/C Video Presentation 3
1 21 AIR CONDITIONING O ™ Aircraft Dimensions (1)
€3 22 AUTOFLIGHT O ** Ground Handling (1)
£ 23 COMMUNICATIONS O ~ Extemnal Visit (2)
0 24 ELECTRICAL POWER 0 ™ A/C General Structure Presentation (1)
£0 25 EQUIPMENT/FURNISHING | O = Cockpit Panels {1)
£ 26 FIRE PROTECTION O = Cockpit Philosophy (1)
01 27 FLIGHT CONTROLS O ™ Other Panels and Racks (1
£ 28 FUEL O ™ Computer R/ (3)
£3 29 HYDRAULIC POWER 1 21 AR CONDITIONING
3 30 ICE AND RAIN PROTECTH
&3 INDICATING/RECORDING L1 Systern Controls and Indicating - General (1)
3 32 LANDING GEAR £ TEMPERATURE CONTROL
£ 33 LIGHTS &1 = System Design Philosophy (1)
B3 34 NAVIGATION O ** System Presentation (2)
0 35 OXYGEN O * System Controls and Indicating (1)
53 36 PNEUMATIC 0 ™ Pack Presentation (1)
C3 38 WATER AND WASTE O ** Flow Control D/O (3)
£ 45 ON BOARD MAINTEMNANC O Pack Sensors D/O [£)]
3 46 AIR TRAFFIC AND INFOR] O ™ Terperature Regulation D/O @)
£ 49 APU O Emergency RAM Air Inlet System D/O (3)
3 52 DOORS O = ECAM Page Presentation 6]
370 cFeA0-E1 ENGINE O ™ Wamings & Operating Limitations @)
3 ™ External Interfaces (=)
O3 COCKPIT/CABIN VENTILATION
O ** System Presentation (]
O = Systemn Controls and Indicating (1)
O ** Warmnings (3)
< | 7| el =
Lesson : ** System Presentation 1) l Mode : Normal
I [Score: D | Status * Not Attempted

Figure 4.1.- List of themes

Each element of the structure has the hyperlink to the corresponding
fragment of text, audio and video explanation (Figure 4.2).

CCDITICNING = SYSTEN ¢

RESETATICN

; THE COCKPIT AND CRBIN ZONES THE LAVATORIES AMD GALLEYS
ARE TEMPERATURE CONTROLLED, - | ARE TEMPERATURE CONTROLLED,
b YENTILATED AND PRESSURIZED. | VENTILATED AMD PRESSURIZED.

Tl —

:%r | o zoie | o zone [ ] PE—
’:@H FUD_CRRED |nze cone e |

THE AVIONICS | [ e ; :

|| COMPARTHMENT IS |-
I | VENTILATED AND |

|

iy

THE BLLK CRRGO
COMPRRTHMENT IS
VENTILATED AND

k PRESSURTZED.
|| cooLING SYSTEM - ; L e SYSTEM IS
© | 1= oPTIONAL) || THE FWD CARGOD COMPRARTMENT . THE AFT CARGO OPTIONAL)

: —_— IS PRESSURIZED. el ] i COMPARTHENT e

: ARl (THE YENTILATION AND THE AIR COND BAY IS5 PRESSURIZED. iR

[ e S TEMPERATLRE CONTROL IS YENTILATED BUT || (THE VENTILATTON

el o =l SYSTEMS ARE ORTIONAL) NOT PRESSURIZED ||SvSTEM IS OPTIONARLY|

AIR CONDITIONING

[ _tocour [ mr | ALDIO [

Figure 4.2.- The screenshot of the training session fragment
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The arrangement of the training session demands to control it. For this the
working environment has control elements (as usual — widgets), which give the
opportunity to get the help, to refer to the glossary, to turn on/off the audio
support, to continue or to exit. The widgets are located at the bottom of the
screen (Figure 4.2).

The screenshot of the glossary is shown on Figure 4.3.

Type the abbreviation ||
K Dearees Kelvin :J
‘R Degrees Rankine
L Thiee Dincrsionsl . Lono. AH _’Ll
4 [ 2

Figure 4.3.- The glossary

The content of the session may contain the video presentation (Figure 4.4).

BROWSE

LOGOLT ELS GLOSSARY

Figure 4.4.- Screenshot of the aircraft presentation

Each theme ends with the quiz.
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. Preliminary unsupervised student’s work (4 hours
Y p

2

L

e

~] O\ Lh

8.
9.
10.
e

[2,

- To revise the skills of operating Microsoft Word.

Get to know the advanced MS Word tools (creating hypertext documents,
statistics).

- To select one type of maintenance operations (transit check, daily check,

aircraft handling operation etc.), performed on the selected aircraft.

To prepare the detailed text description of the operation as the MS Word
file.

To create the ontology of the selected problem domain.

To develop the flow-chart of the operation.

To download the illustrations to the operation and save them as graphical
files.

To define the key words of the theme.

To develop the conceptual model of the training process.

To develop the algorithm of the training process.

To develop the architecture of the training system. For this arrange the set
of files, which contain the elements of the training material.

To prepare the questions to the final quiz.

Progress of work

L

2.

3.

Investigate the CBT technology, using the CBT systems for different
aircraft.

Create the hypertext document, which realizes the links between the
clements of the training material.

Develop the final quiz to the theme.

Control questions

L
2,
3.

Explain the general concept of computer-based training
Specify the general features of the CBT system.
Specify the technology of developing the e-learning manual.

Information sources to the Laboratory Work #4 are given in the folder
“Sources to the LW4” on CD.
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LABORATORY WORK # 5. Developing the database

Key words: data, structure of data, types of data, field, record, table, query,
entities, attributes, data model, database

Objective of the laboratory work: to develop the aircraft database.

Preliminary knowledge and skills
Student must know:
» Types of information and structures of data.
» Notions of table and operations with tables.
Student is to be able:
» To make the analysis of data and data classification.
* To arrange data into tables.

Knowledge after the performing the laboratory work
Student must know:
* The general concept of database.
« Database classification.
* General principles of developing data models.
Student is to be able:
* To develop the data model.
» To transform the data model into tables.
» To develop the database by means of Microsoft Access.

Theoretical background
A database 1s an ordered collection of related data elements intended to

meet the information needs of an organization and designed to be shared by
multiple users.

Note the key terms in the definition:

Ordered collection. A database is a collection of data elements. Not just a
random assembly of data structures, but a collection of data elements put
together deliberately with proper order. The various data elements are linked
together in the most logical manner.

Related data elements. The data elements in a database are not disjointed
structures without any relationships among them. These are related among
themselves and also pertinent to the particular organization.

Information needs. The collection of data elements in a database is there
for a specific purpose. That purpose is to satisfy and meet the information needs
of the organization.
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Shared. All authorized users in an organization can share the information
stored in its database. Integrated information is kept in the database for the
purpose of sharing so that all user groups may collaborate and accomplish the
organization’s objectives.

A database is a simple, yet flexible and powertful tool for storing and
retrieving data. Every company, every website, has lots of data. The more of
your data that you keep in your database - the better.

Whichever database you use - it'll be a relational database. This is the
industry standard design these days. Relational databases use the principles of
set theory. Set theory is a field of mathematics that describes how to deal with
sets of data.

Here are the basics:

 All data is held in tables.

* Atable has columns -fields (along the top) and rows - records.

* You create the tables you need. You define the table names.

* You define what the fields names are in each table.

* You define what type of data the fields contain.

Types of data

There are a number of different data types available which represent the

different aspects of the real life. They are:

* Numerical types, i.e. numbers. There are fundamentally two types: integer
and float. Integers are whole numbers; floats are numbers with decimal
places.

* String types, i.e. text. There are two types: fixed length, and variable
length.

* Date and Time types.

* Binary data. This is arbitrary data, could be images, programs, absolutely
anything,

Often it is necessary to specify the precision of the fields too. This is the
number of digits / decimal places / characters etc.

Also it is necessary to define which column is the primary key. This is the
column that is guaranteed different for all the rows in the table. In the example
table above, it would be the 'order_id' column.

You populate the tables with rows of data. Tables are related to each other by
the columns they have in common-hence relational database!
The database developing process is composed of the specified steps.
The first step is the problem domain definition.
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The second step is the design of the problem domain ontology.

The third step is the identification of the necessary data (entities) to be
stored in the DB, concerned with the problem domain, and defined by the
ontology.

The fourth step is the definition of the relations between entities.

The fifth step is the developing of the data model (entity-relational
diagram).

The six step is the DB program implementation.

Entity-Relationship (ER) Diagrams

An Entity-Relationship (ER) diagram provides a graphical model of the
things that the organization deals with (entities) and how these things are related
to one another (relationships). An ER diagram is a high-level, logical model
used by both end users and database designers to document the data
requirements of an organization. The model is classified as “high-level” because
it does not require detailed information about the data. It is called a “logical
model” because it provides a conceptual understanding of the data and as
opposed to actually defining the way the data will be stored in a database (which
is referred to as the “physical” model).

Entities and Attributes

Entities are things. They can be tangible things, like a classroom or a part,
or they can be intangible things, like a purchase or a meeting. Attributes (or
fields) represent facts about an entity.

For example, an Employee entity might be described by social security
number, name, and address attributes.

Entities are described by at least two attributes. One attribute is a unique
identifier (often referred to as the key field). The value of this attribute must be
unique for each occurrence of an entity. For example, if there were dozens of
employees, then there would be no duplicate values of the key field for any of
the employees. In addition to the key field, there must be at least one other
attribute that provides a fact about an entity. That is, an entity would never be
described solely by a key field.

Relationships

Different entities can be related to one another. For example, in a
university, the Student and the Course entities are related because students
“enroll in” courses. A database must store not only information about the
Student and Course entities, but it must also store the relationship between
Student and Course. For example, the user of the database should be able to ask
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for a list of courses taken by a specific student or ask for a list of students
currently enrolled in a specific course,

The relationship between a Student and Course is called a binary
relationship because it relates to two entities. A relationship between three
entities is called a ternary relationship; when four or more entities participate in
a relationship, it is generally called an n-ary relationship. We restrict our
discussion here to binary relationships but you should be aware that more
complex relationships exist.

Relational Databases

A relational database is made up of a set of tables (files). For example,
Figure 5.1 shows three tables from a hypothetical relational database that
Supports a many-to-many relationship between students and courses.

Student Table Transcript Table

StudentNo Name Address StudentNo | CourseNo | Grade
6634413 | Burrows | 123 Main 6634413 | BA301 [ 32
8743232 Brown 710 Terry 6634413 | BA400 | 3.3
8851000 Welch 4610 17th 8851000 | BA 301 | 35
9243255 Jones 1701 46th 9243255 | FIN350 | 2.9
9659844 Brown 1833 Talbert 9659844 | BA400 | 36

9659844 | FIN350 | 3.0

Course Table

CourseNo Desc
BA 301 Intro to Info Sys
BA 400 Marketing
FIN 350 Intro to Finance

Figure 5.1.- Tables of the database

Each table is made up of a series of rows (records) and attributes (fields).
Key fields, whose values are unique from one row to another, are underlined in
the figure.

When converting an ER diagram into a relational database, each entity
becomes a separate table. In addition, attributes must be added to the tables and
new tables must be created so that the sets of relationships inherent in the ER
diagram are maintained. Finally, a key field must be defined for each table.
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Microsoft Access basics
Load up MS Access 2007 and the opening screen will appear.

ren Microsoft Access
3 SHMERCT S Cek i
Template Categons
Featuring 3 5 i 3
i Getting Started with Microsoft Office Access
From Microsoft Office Online PR e G
Business =
Personal 1=
Sample ._ Blank Database
Education : Featured Online Templates
B S —— e — T -
|
ot
! N
= || .
Projects
Eamem"ne :::ite on Office Online:
New Blank Database
What's new in Access 20072
Blank Database
Click the option ‘New Blank Database’ Blank Database

Create a Microsoft Office Access database that does
not contain any existing data or objects.

At the bottom right of the screen enter a name fletare

for the new database and then click the create button.  CWsersPeulpoaments,

[ greate | [ concel |

MS Access will now open at a screen for e WA T
f'k. / Home Create External Data Database Tools Datasheet

you to enter some data. | & B Treat ||Dsatipe
% 3' E ﬁ ';‘ Delete 9 Farmattin

Format
View New Add Existing Lookup W e
Field  Fields  Column S0 Rename | |53 %+ %0 20

You could at this point double click the = Dt iy

All Tables i <% e

‘Add New Field’ heading and then type in a | 2% :

= Tablel: Table

column name. = il

:. ID ~ FirstName
*| (New)
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Then click in the actual cell and type in ID - FirstName ~ Add New Field
- £ 1 John|
some data S (New)

At the top left click the ‘View’ button and select r|;n,3
the ‘Design View’ option.

This will take you into design view of the table. o | B Ed TEI

Home Create Exter

Access uses tables to store the data. A table in | view | New. 4dd Existing Looku

l ie Fields olum

Access 1s a container with columns such as name, [ l& Colum

Tabl i ‘ i . | Datasheet View  F=——

address etc. Tables are the most important object in _ | s
MS Access and are a useful starting point for any new || 57 pesign view "

database. Sl .

Access will ask you to save the table and to Tatle Name:

. . us mersl N il

enter a name for it. Enter a name and click the ok |+ |
button Lo ][ conce

Now you are in table design view. jw customess
The two columns to be concerned with are |y ,, oo reme Forer e
‘Field Name’ and also ‘Data Type’. Access
has already created a column called ‘ID’.
This is fine and should be left here. ,

Click on the second line and enter a column name. I will be entering
‘FirstName’. You can add a space between the words, but there are good reasons

not to. e —— e
Tab along to the ‘Data Type’ column and click '®,, -
the down arrow. : el
You will then see a list of possible data types to o g
use for the ‘FirstName’ column. = i;’,’im:
In this case for a ‘FirstName’ the most suitable ,Efiki::im )
i
data type would be ‘Text’. O Amnf:fﬂ:f":

FirstName Text

At the bottom of the screen you can set
how many characters should be entered for this e jums

| Field Size 20
‘FirstName’ column. I set it to 20. o
Capt'
ption

Field Properties

Enter some more columns and choose the = vusomes g

Fleld Name B | : Data Type

1 . ?_:'D AutoNumber
appropriate data type and column size C— aut
|Last Name Text
" Address Text
When you are done click the save button,  cny Text
| State/Province Text
| ZIP/Postal Code Text
I,Home Phone Text
E-mail Address Text
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Key

Yiews

Right click the table tab and select the
o e Save

‘Close’ option.

it

r

Rules
Tools

=
“r=1Insert Rows

= Delete Rows

Property
el Lookup Column  sheet

Laboratory work #5

External Data Database Tools Design

(i

g
7

Indexes

Show/Hide

<
-
=1

=% Close

Right click the table and select the ‘Open’ First Namq | Close
option.

All Tables

Customers
ZH customers : Table

@

Open

Design View
Import »
Export »

Collect and Update Data via E-mail

Click in the ‘FirstName’ column and enter some data.

ID  -| FirstName

1 ﬂ_\.nnai
(New)

vi Last Name v% Address v|

Tab along to each field and enter more information.

Click on a new line to enter a new record.

- | First Name ~
1 Anna

2 Antonio

3 Thomas

4 Christina

5 Martin

6 Francisco

7 Ming-Yang

8 Elizabeth

‘ - |

Bedecs

Address - ,
123 1st Street Seattle

Gratacos Solso 123 2nd Street Boston

Axen
Lee
O'Donnell

123 3rd Street Los Angelas
123 4th Street New York
123 5th Street Minneapolis

Pérez-Olaeta 123 6th Street Milwaukee

Xie
Andersen

123 7th Street Boise
123 8th Street Portland

39
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State/Provit ~
WA

MA

CA

NY

N
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ID
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Note: When you enter data into a table or =3 customers"
even a form, MS Access saves it automatically . :: e
Close the table. Ef Close All
Right click the table tab and select the i_‘ il
close option. 0| Pratiable view
) Pigotthart-\liﬂ N

Create a query

A query is used to ask questions and get answers from the data.
Click the Create tab on the Ribbon.

At the section called ‘Other’ select the option called ‘Query Design’.

e Home | Create | Bxernal Data Database Tools

E @ _.j E fi.3] PivotChart o= || = = Labels &l
: i T lBlankForm  —= | [_] Blank Report ==
Table Table SharePoint Table | Form  Split Multiple Form | Report ¢ Report
Templates~  Lists- Design || Form Hems .2 More Forms - Design i3] Report Wizard Design  Wizard Design | ~

Tables | Forms | Reports Other

Select the table to use in the query and then click the
‘Add’ button.

Double click the column names to use in the query

Customers
% 1D

First Name
Last Name
Address
City
State/Province
ZIP/Postal Code
Home Phone
E-mail Address

Field: |First Name iLast Name | Address }Clty State/Province
Table: | Customers | Customers | Customers | Customers Customers
Sort: I : |
Show: | [V _ ¥ ? ¥ |
Criteria: |
orn

Each column will drop into the query design grid.
In this example we must extract all customers in the state of ‘CA’. We do
this by entering ‘CA’ on the criteria line under the state column.
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Field: | First Name Last Name Address City State/Province

Table: | Customers Customers Customers Customers Customers
Sort:

Show: 7l ‘ i V] [v] [v]
Criteria:
ar

V- 3
TDM!
. Home Create E

Now run the query by clicking the ‘Run’ button on the

. ‘T =
Ribbon. !
3 records have been returned for the state of ‘CA’. _— b

| cve

FirstName - lastName - Address - City - State/Provi ~
: 7_1 Thomas Axen 123 3rd Street Los Angelas  CA
| Daniel Goldschmidt 456 16th Streei San Francisco CA
 |Alexander Eggerer 789 19th Streef Los Angelas  CA

e
Removing the criteria from the query grid would return all records.

Preliminary unsupervised student’s work (4 hours)
1. To define the problem space for the DB developing.
To define the entities and relations.
To create the data model.
To arrange data into tables.
To define the names of tables.
To study the general principles of creating databases in Microsoft Access.

BN s L B

Progress of work
1. Create the database with Microsoft Access.
2. Arrange some queries.

Control questions

1. Give the definition of the key notions: field, record, table, query, entities,
attributes, database

Explain the general concept of structure of data

Specify types of data

Explain the general concept of data model

Explain the general principles of database design

Give examples of aviation databases

o U B 08 b

Information sources to the Laboratory Work #5 are given in the folder
“Sources to the LW5” on CD.
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LABORATORY WORK # 6. Aircraft life cycle cost assessment

Key words: life cycle management, life cycle cost assessment, spreadsheets
Objective of the laboratory work: to develop the e-book for the LCC.

Preliminary knowledge and skills
Student must know:
* General concept of aircraft life cycle.
« Life cycle stages.
» The elements and specifics of each stage.
* General principles of spreadsheets operating.

Student is to be able:
To create, edit and save Microsoft Excel spreadsheets

Knowledge after the performing the laboratory work
Student must know:
* General principles of creating, editing and using Microsoft Excel e-books.
» The general methodology of aircraft life cycle cost assessment
Student is to be able:
+ To create, edit and use Microsoft Excel e-books.
 To apply practically the methodology of a technical object or system life
cycle cost assessment

Theoretical background
An aircraft life cycle cost calculation can be performed with the help of

spreadsheets, which are arranged into the e-book. The most popular tool for e-
book creating and operation is the Microsoft Excel.

Microsoft Excel is one of the most popular spreadsheet applications that
helps you manage data, create visually persuasive charts, and thought-provoking
graphs. Excel is supported by both Mac and PC platforms. Microsoft Excel can
also be used to balance a checkbook, create an expense report, build formulas,
and edit them. Figure 6.1. shows the screenshot of the Microsoft Excel 2007
regular window.
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| aria -0 - B 7 u |
C1s - = Refiigerator
A B C D = F G H
1 [Province  «|District » Cold Chain Equip.  ~| Quantit + Model >| Powe ~| Year ~|Source~|
_8 Dodoma Refrigerator 1 V' 240KE Kerozene 1997 JCA
9 |Dodoms ggg:gal} Refrigerator 1 V240KE Kerosene 1995  UNICEF
10 |Dodoma Bagamayo Retrigerstor 1 Y240KE Kerosene 1991 JICA
11 |Dodoma Biharamulo Refrigerator 1 W240KE Kerosene 1893  [JNICEF
12 |Arusha Bunda Refrigerator 1 Mk4010 Electtic 1995  UNICEF
13 |Arusha i Refrigerator 1 RCW424C Electric 1992  UNICEF
14 |Arusha Makete Refrigerator 1 RCW42EK Electric 1991 Jica,
15 |Arusha Muleba Freezer 1 SB142 Electric 1995 JICA,
16 |Dodoma ma:?;‘ngwea Refrigerator 1 Y240KE Kerosene 1993  JiCa
17 |Dodoma [lelanlv.s] Refrigerator 1 V240KE Kerosene 1994  UNICEF
18 |Arusha (NonElanks) Refrigerator 1 MK4010 Electric 1985  UNICEF
19 |Arusha Kilosa Refrigerator . 1 RCWA2EG Eleciric 1996  UNICEF
20 |Arusha Kilosa Refrigerator 1 ROMWA42EK Electtic 1998  UMICEF
21 lArusha Kilosa Freezer 1 SB142 Electric 1995  UMNICEF
Figure 6.1.- Screenshot of the Microsoft Excel window
Toolbars

In Microsoft Excel 2007 for a PC, the toolbars are automatically placed as
tabs at the top of the screen. Within these tabs you will find all of your options
to change text, data, page layout, and more. To be able access all of the certain
toolbars you need to click on a certain tab that is located towards the top of the

screen.

The Home Tab: (Figure 6.2). This is one of the most common tabs used in
Excel. You are able to format the text in your document, cut, copy, and paste

information.

Change the alignment of your data, insert, delete, and format cells. The
Home Tab also allows you to change the number of your data (i.e. currency,

time, date).

fs C!.-a H q_v Eu,,,- X
4 h a -

23 ¥ o

1
a3 Copy
Paste

Clipboard

' Home j} Insert Page Layout Formulas Data

Calibri it 1 TR

- JF Format Painter B I U 'H‘

P

T?igu?e 52.— HomeiT_ab -

Review View

A x| [= ==fm] |Swepren

i Alignment

Bookl - M

Ta

The Insert Tab: (Figure 6.3). This tab is mainly used for inserting visuals
and graphics into your document. There are various different things that can be
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inserted from this tab such as pictures, clip art, charts, links, headers and footers,
and word art.

) d v - s Eookl - Microsoft Excel
v

Home Insert | Page Layout Formulas Data Review View

5 3 uﬂwzq il k) @

PwotTabie Table Picture ‘Shapes SmartArt Co]umn Llne Pie Bar Alea Scatter Other Hyperlink Text Header WordArt
= o Y. Charts - Box & Footer ¥

Tables llustrations Charts I Links Te

Figure 6.3.-. Insert Tab

The Page Layout Tab: (Figure 6.4). Here you are able to add margins,
themes to your document, change the orientation, page breaks, and titles. The
scale fit of your document is also included as a feature within this tab, if needed.

r 2 i - s Bookl - Microsoft Excel
- Home  Insert Page Layout | Formulas Data  Review  View
e ECoIorS‘ [ IE fg =l | 3] % 131 Width: Automatic ~  Gridlines | Headings
l | — " e I o |
"""" [A]Fonts ~ : 2 =l 71 Height: Automatic ~ ¥ View |V View
Themes — Margins Orientation Size Print Breaks Background Print ) = = ! s
- Eﬂeds b . - - Area~ - Titles ||t Scale: 100% ' Print [ ] Print
Themes Page Setup f Scale to Fit ] Sheet Options 1=

Figure 6.4.-. Page Layout Tab

Working with cells

Cells are an important part of any project bemg used in M1c1050ft Excel.
Cells hold all of the data that is being used to B
create the spreadsheet or workbook. To enter | | A B
data into a cell you simply click once inside of | 4 = =
the desired cell, a black border will appear | |
around the cell (Figure 6.5). This border | =
indicates that it is a selected cell. You may then 3
begin typing in the data for that cell. Figure 6.5 - Entering Data

Changing an entry within a cell
You may change an entry within a cell two different ways:

« Click the cell one time and begin typing. The new information will replace
any information that was previously entered.

« Double click the cell and a cursor will appear inside. This allows you to edit
certain pieces of information within the cells instead of replacing all of the
data.
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Cut, copy, and paste

You can use the Cut, Copy and Paste features of Excel to change the data
within your spreadsheet, to move data from other spreadsheets into new
spreadsheets, and to save yourself the time of re-entering information in a
spreadsheet. Cut will actually remove the selection from the original location
and allow it to be placed somewhere else. Copy allows you to leave the original
selection where it is and insert a copy elsewhere. Paste is used to insert data that
has been cut or copied.

To Cut or Copy: highlight the data or text by selecting the cells that they
are held within. Go to the Home Tab > Copy (CTRL + C) or Home Tab > Cut
(CTRL + X). Click the location where the information should be placed. Go to
Home Tab > Paste (CTRL + V) to be able to paste your information.

Formatting cells

There are various different REIEIRE . ux
options that can be changed to — Mmber [owent]] rort | porder | Fa | protecion |
Text alignment ~Orientation————
format the spreadsheets cells Mm
; . iy ! .
differently. When changing the ﬁ’:" ¥ !lf_g B .
format within cells you must select - footom =] 1
o I' Lstify distribute .
the cells that you wish to format. i 1.
To get to the Format Cells r’t o _@W‘f
dialog box select the cells you wish = I wegecus
Right-to-left
to change then go to Home Tab > e
Format > Format Cells. A box will [comter~]
appear on the screen with six
different tab options (Figure 6.6).
Explanations of the basic options in
p p | oK I Canicel

the format dialog box are bulleted
below. Figure 6.6.- Formatting Cells

Number allows you to change
the measurement in which your data is used. (If your data is concerned with
money the number that you would use is currency).

Alignment. This allows you to change the horizontal and vertical
alignment of your text within each cell. You can also change the orientation of
the text within the cells and the control of the text within the cells as well.

Font gives the option to change the size, style, color, and effects.

Border. gives the option to change the design of the border around or
through the cells.
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Formatting rows and columns

When formatting rows and columns you can change the height, choose for
your information to autofit to the cells, hide information within a row or column,
un-hide the information. To format a row or column go to Home Tab > Row
Height (or Column Height), then choose which height you are going to use
(Figure 9). The cell or cells that are going to be formatted need to be selected
before doing this.

When adding a row or column you are inserting a blank row or column
next to your already entered data. Before you can add a Row you are going to
have to select the row that you wish for your new row to be placed. (Rows are
on the left hand side of the spreadsheet) once the row is selected it is going to
highlight the entire row that you chose. To insert the row you have to go to
Home Tab > Insert > Insert Sheet Rows. The row will automatically be placed
on the spreadsheet and any data that was selected in the original row will be
moved down below the new row.

Before you can add a Column you are going to have to select a column on
the spreadsheet that is located in the area that you want to enter the new column.

(Columns are on the top part of the spreadsheet.) Once the column is
selected it is going to highlight the entire row that you chose. To insert a column
you have to go to Home Tab > Insert > Insert Sheet Column. The column will
automatically be place on the spreadsheet and any data to the right of the new
column will be moved more to the right.

Working with charts

Charts are an important part to being able to create a visual for
spreadsheet data. In order to create a chart within Excel the data that is going to
be used for it needs to be entered already into the spreadsheet document. Once
the data is entered, the cells that are going to be used for the chart need to be
highlighted so that the software knows what to include. Next, click on the Insert
Tab that is located at the top of the screen. (Figure 6.7).

(6;:3. H Dt £ Bookl - Microsoft Excel
Lad .

Home Insert | Page Layout Formulas Data Review View

PivotTable Table  Picture | Cllp Shapes SmartArt Column Llne Pie Bar Area Scatter Other  Hyperlink = Text Header WordArt

Art 50 * 52 ¥ & Charts ~ Box & Footer

Tables Hlustrations Charts

Figure 6.7.- Charts Tab

Links
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You may choose the chart that is desired by ST
clicking the category of the chart you will use. Once the
category is chosen the charts will appear as small
graphics within a drop down menu. To choose a & °
particular chart just click on its icon and it will be |* °
placed within the spreadsheet you are working on. To =
move the chart to a page of its own, select the border of the chart and Right
Click. This will bring up a drop down menu; navigate to the option that savs
Move Chart. This will bring up a dialog box that says Chart Location. From
here you will need to select the circle next to As 4 New Sheet and name the
sheet that will hold your chart. The chart will pop up larger in a separate sheet.
but in the same workbook as your entered data.

Chart design

There are various different features that you can change to make your
chart more appealing. To be able to make these changes you will need to have
the chart selected or be viewing the chart page that is within your workbook.
Once you have done that the Design Tab will appear highlighted with various
different options to format your graphic (F igure 6.8).

-
ol Home Insert Page Layout Formulas Data Review View

i T 55 s Ri= e
AR
| gy g A =R
Chan Save A Switch  Select L i =
Chart Type Template  Row/Column Data T

Type Data Chart Layouts

Lhart Styles

Figure 6.8.- Design Tab for chart design

Chart options

Titles. To add titles to a chart of graphic you have to click on the Insert
Tab. Once you have done this, click on the Text Box Icon. This will insert a text
box that you can type the title and place anywhere you wish on the chart.

Change Chart Type. You can change your chart easily by selecting this
icon and navigating to a more desirable chart. This feature is very convenient for
someone who chose the wrong chart and doesn’t wish to reselect all their data
and go through the process a second time.

Format Chart Area. This allows for changes to be made to the chards
border, style, fill, shadows, and more. To get this option you will need to right
click on the charts border and navigate to the Formar Chart Area option. Once
this is clicked a dialog box will appear.
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You are able to change the color of the bars that are within your chart.

Creating functions

When creating a function in Excel you must first have
the data that you wish to perform the function with selected. |-
Select the cell that you wish for the calculation to be entered
in (i.e.: if I want to know the sum of B1:B5 T will highlight
cell B6 for my sum to be entered into). Once you have done
this you will need to select the Formulas Tab located at the
top of the screen. A list of Most Recently Used, Financial, Logical, Text, Date
and Time, Math and Trig formulas will appear. To choose one of the formulas
click the icon that holds the formula you are looking for.

Once you have clicked your formula this will display a dialog box on your

screen. (Figure 6.9)

Jhd Bl

~SUM

Number1 | £x] = {89;56;42;7383;52;53;53;5)
Mumber2 r &l = number

Adds &l the numbers in a range of cells,

Numberl: numberl,numberZ,... are 1 to 255 numbers to sum. Logical values and text
are ignored in cels, included ¥ typed a5 arguments.

Formula result = 7734

Help on this function oK | Cancel

Figure 6.9.- First calculation display

In this screen it lists the cells that are being calculated, the values within
the cells, and the end result.

To accept that calculation you can press OK and the result will show up in
the selected cell.

Undo and redo
In order to undo an action, you can click on the blue arrow icon that is
pointing to the left at the top of the screen. To redo an action, you can click on
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the blue arrow icon pointing to the right. It is important to note that not zll
actions are undoable, thus it is important to save before you make any major
changes in your document so you can revert back to your saved document.

Quitting

Before you quit, it's a good idea to save your document one final time.
You will need to choose the Office Icon and choose Exit Excel. This is better
than just closing the window, as it insures your document quits correctly.

Preliminary unsupervised student’s work (4 hours)
1. To revise the skills of operating Microsoft Excel.
2. To investigate the information about the cost of the phases of selected
aircraft life cycle.
3. To define the positions of expenses for each phase.

Progress of work

Create the one sheet for the calculating expenses of each LC phase.
Calculate the total expenses of each phase.

Create the resultant sheet at the end of the book.

Using references create the resultant table.

Calculate the total LCC.

Compare the expenses of different phases. For this plot the pie chart.
Investigate the possible expenses for different market situations (for three
years). Plot the graph.

8. Arrange the legend for each chart.

> S B ke b B

Control questions

What are general principles of creating Microsoft Excel e-books?
What are advantages and disadvantages of spreadsheets?

Specify the main properties of spreadsheet.

Explain the principles of creating links between the worksheets.
Give the brief characteristic of the life cycle cost assessment
methodology.

Make the analysis of main problems of an aircraft life cycle
assessment.

e L9 B

24

Information sources to the Laboratory Work #6 are given in the folder
“Sources to the LW6” on CD.
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LABORATORY WORK # 7. Developing training and business
presentations with computer technologies

Key words: presentation, slide, palette, color schemes, multibranch

Objective of the laboratory work: to develop the multibranch interactive
presentation, training presentation.

Preliminary knowledge and skills
Student must know:

» The notion of algorithm

 General principles of developing multibranch algorithms

+ General principles of creating flowcharts

+ Basic principles of creating presentations with Microsoft Power Point
Student is to be able:

« To develop the multibranch algorithm

« To develop simple presentations with Microsoft Power Point

Knowledge after the performing the laboratory work

Student must know:

« The technology of developing multibranch interactive presentations
« Requirements to the training and business presentations

 General principles of creating quizes

Student is to be able:

To develop the multibranch algorithm of training session

To develop multibranch interactive training presentation

To develop proper business presentations

To develop the quiz

Theoretical background
Microsoft PowerPoint is one of the most popular presentation programs

supported by both Mac and PC platforms. Microsoft PowerPoint can be used to
create interactive presentations for classroom, business, or personal use.

Toolbars

Microsoft PowerPoint uses several toolbars to allow you to modify your
document. When you first open PowerPoint, usually the toolbars discussed
below will open.
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The Home bar (Figure 7.1). This toolbar has features that allow you to
edit Slides, Fonts, Paragraph, Drawing and Editing. This is the only toolba
that you can edit these options from.

k755
~—"  Home lnsm Design Animations Shde Show Review View
| Layout - o e T |In T ENXOOD J_l] E
P Reset AL ey IR SR L shape Ou I Fepiace -
z AV = A . _ Arange Quick
3 Sinker Sllde +J Delete Bl ds & A Ay-|| A e «‘«‘p\_{ 3 fy s sl e e o & Seec -
Clipboard il Slides Font Paragraph Drawing

Figure 7.1.- Home Tab selected

The Insert bar (Figure 7.2). This toolbar has features that allow you to
add Tables, Illustrations, Links, Text, and Media Clips.

) | : ; :
~ Hame Insert | Design Animatrons Slide Show Review

‘ o gl = o - = o R e f ! o

O BB d @il k4T &Y

[ o Lj{_] m E-:_, %':?_;J - -_),J‘ | s |l = WA ﬂ

Table || Piture Clip Photo Shapes SmartArt Chart Hyperlink Action Text Header WordArt Date  Slide Symbol Object = Movie Sound
¥, At Album~+ - Box & Footer Y & Time Number X Y,

Tables Tustrations Links Text Media Clips

Figure 7.2.- Insert Tab selected

The Design bar (Figure 7.3). This toolbar has features that allow you to
edit how your presentation will look. It includes features such as Page Setup,
Themes, and Background.

B2y v
:—/ Home  Inset  Design | Animations SliceShnw Rniew View

- [ cotars -

3 Background Styles ~

OB N (v
[ o == s
Page Slide mmsmns || smemne owanns | flwoswen | snzmen 7| Hide Backgraund Graphics
Setup Onjentation - | =
Fage Setup ! Themes i Background

Figure 7.3.- Design Tab Selected

The Animations bar (Figure 7.4). This toolbar has features that allow you
to add custom animations to your presentation. You can select from Preview,
Animations, and Transitions. By selecting Custom Animation in the
Animations box, you can apply effects to individual elements in your
presentation.

) e
- Home Insert Design Animations | Siimshow R!rlaw View

[ 7; L I sk Transition Sound: [Ne Sound] || Advance Slide
.y L2 Anima =t -

" & + 1 Transition Speed: Fast - ¥ OnMouse Click
Preview 1% Custom Animation =3 _,

I

T a) ApplyTo All | T Automatically After. 0000  ©

| Preview Animations Transition to This Shide

Figure 7.4.- Animations Tab Selected
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The Slide Show bar (Figure 7.5). This toolbar has features that allow you
to select how your presentation will be displayed. From here, you can Start your
Slide Show, Set Up your Slide Show, and Adjust Monitor Settings.

-/ Home Insert Design Animatlons Slide Show Review View
- T = 7] WD Record Narration '=1] Resolution: Use Current Resolution  ~
_w g el I s
i e = é-’ Rehearse Timings & Show Presentation On
From From Custom Set Up Hide ;
Beginning Current Stide | Slide Show > | Slide Show Slide ¥ Use Rehearsed Timings Use Presenter View
Set Up Monitors

Start Slide Show

Figure 7.5. Slide Show Tab Selected.

The Review bar (Figure 7.6). This toolbar has features that allow you to

Proofread, Comment Slides, and Protect (Lock) the Presentation

Ammatlons Shde Show Review 1 View
8

Y Home e Design

: Py l’s? : " |

B (4 [ 8 B ]_J_J_za_,a_rz.
3 Show | New Edit Delete Previo Mext Protect

Presentation ~

Spelling Research Thesaurus Transiate Languags
Markup ' Comment Commeant -
Proofing Commeants Protect
Figure 7.6.- Review Tab Selected

The View bar (Figure 7.7). This toolbar has features that allow you to set
the View of your Presentation, Show/Hide Features, Zoom, Switch from Color

to Grayscale, Adjust Windows, and Add Macros.

Design Animations Slide Show RE\H!W View i
' i L [ S | Ruler q [' Color ;‘.]] E.&mange Al | | %? =
| [ : Gridlines I Grayscale —' B Cascade | | =2
i Nurmaf Slide Notes Slide Slide Handout Notes Zoom Fitto l Switch | Macros
| Sorter Page Show | Master Master Master Message Bar Window |l Pure Black and White Wm:ww £ Move Split | windows -
Show/Hide Zoom Color/Grayscale Window Macros

Presentation Views

Figure 7.7.- View Tab Selected

Formatting the presentation
The default slide design for a Microsoft PowerPoint document is a blank

slide. If you want your slides to have a design, you must add one. To do this, go
to Tool Ribbon > Design Tab (Figure 7.8) and select the design that you like.

The design is instantly applied when you click on it
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Page

WE Egr—l @ F-:TI m AL et

Figure 7.8.- Applying Slide Themes

Formatting the slide layout

From the Home tab, select Layout (Figure
7.9) from the Slide box and select your preferred
layout. From here, you can specify how the content
on your slide is displayed. To apply a layout to your
slide, click on the preferred style.

Inserting and adding objects

o ] Layout ~
- Reset
5?;;:”7 Delete
Slides

Figure 7.9.- Adjusting
Slide Layout

Clip art. 'When trying to enhance your word document you may want to
include Clip Art and/or Word Art. Microsoft PowerPoint comes with a Clip
Gallery that contains a large variety of images including pictures, borders, and
backgrounds. To find a desired image, you can either click on topics or type in
the search box to find exactly what you are looking for. To insert Clip Art: Go to
the Insert Tab and select Clip Art. and then select the desired picture in the Clip
Gallery and click insert. The picture will be inserted at the location of your
cursor within your document. If you need to modify your Clip Art, click on it
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once to select it, and small boxes will appear around the corners. Once your Clip
Art is selected, you can resize your picture by clicking and dragging on the
boxes. Holding SHIFT while clicking and dragging will resize the Clip Art
proportionately.

WordArt is inserted similar to Clip Art. To insert WordArt: Go to the
Insert Tab > WordArt Select the desired style and click OK. Type the desired
text and click OK. To select your WordArt, click on it, and small boxes will
appear in the corners. Moving the yellow box on a

selected WordArt allows the user to change the slant of Home  Insert
the WordArt. WordArt can be resized and deleted = B ,
similarly to Clip Art. l bl | &) L
Pictures. To insert a picture select the Insert Tab > Pidure Clip Pho
Picture. Locate the image that you want to put into your At Albul

document and click Insert. 3 Il

Inserting slides from a previously created file

To insert a slide from | vome |[tnsert " Design " Animations
another presentation go to the - =
Home tab > New Slide > =
Reuse Slides.(Figure 7.10.),
select the slide that you wish [
to insert into your

presentatlon Title Slide - t Section Header

Creating a table R

To create a table within | o :
your document, go to the
Insert Tab > Table. Choose
the desired table size by
dragging your mouse over the
squares, and click. The table
will be inserted at the cursor's
location within your

Comparison Title Only

Two Content

Content with Picture with
Captmn Captmn

Biank

LE]I Duplicate Selected Slides
LE:-] 1 Slides from Qutline...

document. To navigate within
your table, use the arrow keys. Figure 7.10.- Inserting a Slide from Another

Presentation
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l Flowcharts
: "Flowcharts are used to create diagrams in Microsoft PowerPoint. To
draw a Flowchart go to the Home Tab and click the Down Arrow to access
Flowchart (Figure 7.11). Once the Drawing toolbar is open, click and hold on
the AutoShapes button until a side menu appears. Continue holding down the
mouse while you drag the cursor over to Flowchart, and then to the desired
shape (Figure 7.11). The cursor will
appear as crosshairs. Position these
crosshairs where you want to place the
flowchart in your document and click QB O
and drag to the desired size. You can R Banr' Flawchart: Summingjunmonl
then use the Drawing toolbar to fill : T
this shape with words and/or Figure?7.11.- Inserting Flowcharts
pictures/color. To draw connecting

lines between the shapes: Click and hold on the Lines button on the Drawing
toolbar until the side menu appears. Continue holding down the mouse and
select the desired line style. Click and drag your line from the first shape to the
connecting shape.

Flowchart
OO JO0008cC ey
CUCINDD X 6 ATVCD

Undo and redo

In order to undo an action, go to the top of the window on the left and
click on the Arrow Pointing to the Left (Undo). To redo an action, go to click
on the arrow Pointing to the Right. 1t is important to note that not all actions
are undoable, thus it is important to save before you make any major changes in
your document so you can revert back to your saved document.

Quitting

Before you quit, it's a good idea to save your document one final time.
Then, go to Office Button > Quit PowerPoint. This is better than Just closing
the window, as it insures your document quits correctly.
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Shortcut keys for Microsoft office

The shortcut keys listed below can be a great help when using Microsoft
Office products. Not only are they quick and easy, they are also amazing time
savers.

CTRL+K Create a Hyperlink

CTRL+/ Display HTML Tags

CTRL+T Create an Auto Thumbnail Of Picture
CTRL+SHIFT+B Freview Page in Web Browser
SHIFT+ALT+F11 Display Script Editor

CTRL+N Create a New Slide

CTRL+B Bold

CTRL+l Italic

CTRL+U Underline

CTRL+C Copy

CTRL+V Paste

CTRL+S Save

CTRL+P Print

CTRL+O Open

General guidelines for PowerPoint Presentation writing, design, text,
graphics and color

Before the Presentation:

+ Check to see if the equipment will work properly

« See if the projector’s resolution is the same as that on your computer

+ Determine how far you will stand from the audience and how far the
audience will be from the screen. This will help determine your font size,
which can account for 90 percent of your success.

» Generally use only equipment you are familiar with. Take your own, if
possible.

 If using another PC, make sure PowerPoint is installed or that it is the
same version as the one you created the presentation in.

» Cut off screensaver. You don’t want to apologize for your home pictures.

» Cut off standby. If you are talking and the screen goes into standby if may
take a while to get back to the presentation or it may require you to
reboot. (Start, Settings, Control Panel, Power, Power Schemes, System
Standby — Never)
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Writing Guidelines

Organize the entire presentation before you create the PowerPoint
presentation

Determine the key points you want to make

Make sure you thoroughly researched your topic

Determine the purpose of the presentation — entertain, inform, persuade or
sell. Is it lighthearted or formal — this will also help you determine colors.
clip art and templates.

Remember you are not there to overwhelm the audience or demonstrate
every bell and whistle of the software.

Don’t get caught up in the gee-whiz.

Write an outline for each slide.

Eliminate unnecessary words on slides. Think about writing headlines.

Design Guidelines

Make a pact with the devil — remember 666 — no more than six word
slides in a row, no more than 6 bullets on a slide and 6 words to each
bullet

A long list can overwhelm an audience.

All text should be 18 to 20 points or larger.

Fonts should be easy to read. Try Arial, Helvetica or Tahoma they work
well.

Choose one font and font size for headlines and another font and font size
for body text. Headline fonts should be san serif and body copy should be
serif type. Remember, serif is with feet. San serif without feet.

Do not use more than 3 fonts.

Use no more than two levels of bullets (Level 1 headings for main topics
and Level 2 headings for subtopics).

Organize the elements of the slides in advance. Decide which elements
are the most important and the least important and organize them
accordingly.

Emphasize text with bold, size, color, and spacing formatting. Be careful
with italic, it can be hard to read.

Consider creating a visual theme by selecting colors and graphics related
to the topic of the presentation.

For slides containing a lot of text, choose simple backgrounds.

Use bright colors in small areas for emphasis.
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» After designing the slides, stand back and examine them. Make any
needed adjustments. Do the drop test to see if you can read the slide. Print
out a copy. Drop the paper to the floor. Stand and see if you can read the
material. If you can’t, you need to start over.

Text Guidelines

» Avoid using all caps. (ALL CAPS ARE MORE DIFFICULT TO READ
THAN UPPER AND LOWER CASE TYPE.) Research shows that it
takes 57 percent longer to read all caps.

« Choose readable fonts. Also use standard fonts. If you create a
presentation and use a non-standard font and use a different PC for the
presentation, the machine will substitute a font for you.

» Ifusing WordArt, use it sparingly. Prefer not use WordArt at all.

» Write phrases, not sentences.

« Less is more. Keep the line length of text to no more than 45 to 55
characters, including spaces. Longer lines are difficult for the audience to

read.

» Avoid underlining text. Use italic or bold type instead. Use both
sparingly.

+ Iftext is placed over a color graphic, make sure the text is readable on all
parts of the slide.

» Be careful when using rotated and vertical text.
» Allow for margins on slides. Make sure everything on the slide can be
seen or read.

Graphics Guidelines

 Limit the use of lines to three or four lines per slide.

» Choose graphics that relate to the topic.

» Make use of white space.

« Limit the number of graphics per slide. Keep graphics throughout the
presentation in the same family.

» Simplify data labels.

» Use photographs sparingly. They take up a lot of space and if you use a
laptop with limited space, you may have to run the presentation from the
disc, making everything slower.

« If you have clipart on every slide, you are doing something wrong.

« Don’t animate unless you need to make a point.
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Color Guidelines

« Use a limited number of colors.

* Choose colors that contrast for text and background.

* Because some people have problems distinguishing certain colors, avoid
using certain color combinations including: red/green, brown/green.
blue/black, and blue/purple.

* Use cool and muted colors for backgrounds. Bright warm colors are hard
to look at for a long period of time.

* Light backgrounds with dark text can be used to create a soft 1ook.

* Use PowerPoint's built-in color schemes.

* Colors help set a tone. Generally blue, green and gray say professional.
Red and orange are high energy, but can be difficult to look at for long
periods. Use them sparingly.

* For text colors white and yellow or a black background are best. Cyan and
bright green on a dark background are second best. There is a reason that
traffic signs are yellow and black. They are easy to see and read.

The Slide Master

The Slide Master of a PowerPoint presentation can be a very helpful tool
in creating and carrying out a presentation design. It is a part of the design
template of a slide that stores information about the template, including font
styles, placeholder sizes and positions, background design, and color schemes. It
functions as the skeleton of a presentation. The Slide Master defines the options
for every slide in a presentation.

To make the most of the Slide Master:

* Format the background - Create a background for the slides in a
presentation. A PowerPoint template can be used, a background can be
created using PowerPoint tools, or a background can be imported from
another source. Once the background is added to the slide master, it will
appear on every slide in the presentation.

* Define the color scheme - PowerPoint's built-in color schemes can be
used or a color scheme can be created.

* Select fonts and bullets - By applying fonts to the Slide Master, font
formatting will be applied to all slides in the presentation.

* Add logos or other elements to each slide - Any graphic elements that
need to appear on each slide can be added here.
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Using Charts and Graphs
Charts and graphs can be a very effective part of a presentation, but each

chart and graph should have a purpose that adds to the presentation's overall
effectiveness. A common mistake is adding unnecessary charts and graphs to a
presentation. Use charts to highlight key points of a presentation. When
designing charts and graphs for presentations:

Guide the eye to the main point - The main point of the chart or graph
should jump out at the audience. Arrows, animation, or color can be used
to draw the eye to the main point.

Limit the number of lines - Make charts and graphs as simple as possible.
A single data series, such as a line or row of bars, per chart or graph is
best. Too many lines can be confusing.

Use either an axis scale or data points - Do not use both. Keep charts and
graphs as simple as possible.

Remove details - Remove details including grid lines, footnotes, and other
details whenever possible. They can distract from the main point.

Slide Transition
Use PowerPoint slide transitions wisely. Many transition options are

available, but they should be used with reserve. A good solution is to choose a
simple transition and apply it to every slide in the presentation. Rules to follow
for slide transitions include:

When using sections to divide a presentation, a second transition can be
used for the introductory slide for each section.

Slide transitions, like animations, lose their effectiveness when used more
than a few times.

Slide transitions should not distract from the content of the presentation,

so the best ones blend into the overall presentation.

More recommendations are given in Appendix D.

Preliminary unsupervised student’s work (4 hours)

1.

W

Study the general principles of creating training interactive presentations
and games.

Develop the algorithm of the interactive training session. For this use the
previously prepared interactive e-guide.

Choose some pictures and video to illustrate the teaching material.
Develop the algorithm for implementation the interactive quiz.
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5. Correspond the portions of text and video materials with training
situation, which the branches of algorithm create.
6. Provide the control elements in the presentation.
. Develop the draft of business presentation on the subject of 1% or 2™
Homework. Follow requirements to the business presentations.

A
.

Progress of work
# 1. Create the interactive training presentation, including the quiz.

Control questions
1. What are general demands to the business presentations?
2. Compare the specifics of training and business presentations.

Information sources to the Laboratory Work #7 are given in the folder
“Sources to the LW7” on CD.
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Appendix A

NATIONAL AVIATION UNIVERSITY
AEROSPACE INSTITUTE
AIRCRAFT FACULTY
AURCRAFT AIRWORTHINESS RETAINING DEPARTMENT

HOMEWORK #1
ON THE DISCIPLINE

“AJRCRAFT LIFE CYCLE SUPPORTING COMPUTER TECHNOLOGIES”

CONCEPTUAL MODEL OF AIRBUS 380 LIFE CYCLE

Performed by student of 305 FLA Litvinova Svetlana
Checked by L. Zhuravlova
Date
Mark Signature

Kyiv

2012
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Appendix C

Methodical recommendations to the performance of the Homework #1

“CONCEPTUAL MODEL OF <concrete aircraft> LIFE CYCLE”

All information, collected during the performing of Laboratory works, can

be used for the arrangement of the Homework #1.

ool et

(@)

o0

10.
11.
12
13.
14.
15,

The main steps are the next.

Choose the type of an aircraft

Investigate its market position

Investigate the life cycle strategy

Estimate the cost of each life cycle stage.

Investigate, what computer technologies are applied on each stage of the
aircraft life cycle. Estimate the cost of software developed (or purchased).
Pay attention on databases.

. Define the problem domain of the aircraft life cycle.

Create the ontology of the problem domain. Restrict it, if possible. Define
the criteria of restriction.
Design the ontograph of the problem domain.

. Define the key notions, which correlate with the most important objects of

the problem domain.

Specify the relations between objects.

Specify the input (inputs) and output (outputs) of the conceptual model.
Specify the key characteristics of the elements of the conceptual model.
Develop the algorithm of the conceptual model functioning.

Create the flow-chart of the algorithm.

Arrange the conceptual model guide, following the requirements to the

technical documentation.

Methodical recommendations to the performance of the Homework #2

“Developing the Business Power Point presentation “Aircraft life cycle

2999

Use the Homework #1 for the performance of this Homework.

. Specify the general objective of the work. Define the local goals of the

work.

Develop the algorithm of the presentation.

Correlate each step of the algorithm with the actual information. Define
the form of presentation this information: text, diagram, video, or picture.
Transform the portions of information to the slides of the presentation.
Follow the recommendations for creating proper presentations.
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Appendix D

Tips for Effective Presentations

« Allow one minute per slide - An audience has a short attention span
and if you spend longer than one minute per side, you risk losing the attention of
the audience.

e Don't read your slides - Put your key points on your slides and use
speaker notes for your presentation.

 When using charts and graphs, highlight the bottom line - Re-
enforce your message by highlighting the benefits or bottom line results.

 Dim the lights - Use dark backgrounds with light-color text. This will
provide good contrast for projection in a light-dimmed room.

« Maintain eye contact with your audience - Practice your presentation
until you are able to discuss your subject without reading your slides. Position
yourself so that you can have eye contact with most of the people in the room.

Some General Tips:

» Keep in mind, most people read from left to right and from top to
bottom. They also tend to notice dark or bright areas before light ones. Consider
this when placing elements on a slide.

* Consider using backgrounds that are neither very light nor very dark.
Very dark backgrounds are usually used with white or yellow text for contrast,
but the result can be hard on the eye. To create a softer effect, use a medium
green or blue, but be sure there is sufficient contrast with the color of the text.

» A watermarked company logo can work well as a slide background.

7 Steps for Preparing Powerful Presentation

1. State the objectives and write them down — at the end of the
presentation I want the audience to think... I want her to do .... I want them to
say... I want him to feel.

2. Answer the basic questions — why am [ making the presentation? What
am I going to say? What do the audience want to hear? Who am I saying it to?
Where will I be saying it?

3. Use a clear and logical structure — break your material into manageable
“chunks” like the chapters in a book. Share the structure with your audience, it
will help them too.

4. Tell the audience what they want to hear, nothing more — they don’t
want to hear everything that you know, or have done. They want to hear the
parts that are relevant to them.
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5. Think of your presentation as telling as story — there should be a
beginning, a middle and an end. Each part should flow logically from the
previous part and it should be told in your natural style of speech.

6. Spend time on the opening words of the presentation — you need to grab
the audience’s attention while you have the change, once you have lost their
attention it is very hard to get it back.

7 Rehearse with someone who doesn’t know the subject — they can tell
you whether or not it is clear, whether you have missed something and most
importantly whether it meets the objectives you set in Step 1

10 Power Tips for Calming Presentation Butterflies

1. Arrive early and walk briskly around the room before anyone is there,
making it your own.

2. Greet audience members as they come in, shaking hands and building
friendship bridges.

3. Go to an out-of-sight area and bend from the waist, letting your hands
and arms drop to the ground.

4, Take deep breaths, letting the air out slowly.

5 Tense and relax the muscles in your face, arms, stomach and legs.

6. Stretch your neck, arms and legs.

7. Concentrate on your Success.

8. Visualize the audience as you want then to act immediately after the
presentation.

9. Engage in positive self-talk about your excellent presentation.

10. Tell a story or anecdote very early on that will require you to move
around, make large gestures or raise your voice — any of which will serve as a
release for your nervous energy.
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